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Introduction

C based design

Time-to-market pressure

Development (x5)
— Initial RTL design is very hard and time consuming job.

Design Space Exploration (x20)
- Modifying the system is very much easier in C than in RTL.

System Level Design
Abstract level is becoming higher and higher

transistor level = gate level = register transfer level 22



High Level Code Structure

1 Header files \

o Data files \

1 Source files et \
Driver files \/.

= arbitrary C/C++
PPA file

w synthesizable C \/

Data

SW Testbench

Code Synthesized
to HW

driver.h

ppa.h

—

driveri.c

driver2.cpp

1 Result files

Result
Outputs




Real Code Example

Example - /home /sjyoon/example1/

Driver

= 147.46,219.232 - PuTTY

main |
npaid:
b, i, i:

main.c [+]
— INSERT —

Code

+ argv[]) {

over|apinpaid,

PPA Code

ALH][N]
BILI[M][M]:

W, ¥, output_num:

tenp[M] [M]

for Ci=00 0 < M
for (j=0:

i++) 4
Mo j++) 4

i
i tenp[il10i] =

uutubt rum][j][ j .
[

Stenplil[i] = tenpli1 01

4% exanple. o [+]

wox WLTHT « 40T




Real Code Example

Driver Code| PPA Code

Stream Output

Pipeline of Processing Arrays



Real Code Example

PPA PA PE PPA COde

PE

PA PE
PE

ATM][N]

Stream Input E B [L] [H] [”] H
| = ¥, ¥, output_nun:
I l B

P

Host Timing

Interface Controller — \ :' fed Tem [ZI[H] [”] ;

FIFO for (i=0s 0 < Wi i++) {

'HEEE N

| | ] : _tenp[i][i wo+ ALIT0I] = AL EHS

Task Frame

I'u"lerrlar!u' e ! . o .
| 21 Bloutput _num] . i1l |] =y
1T s ] = tenpl[i][i] + templil[i]:
- 4

Stream Output

Pipeline of Processing Arrays




Architecture Template for PICO
Express Hardware

Stream Input

a R P
) i i 5 : _rl Fixed Control _l, :
R e Host % e Tlmlng 4_"‘ PA 1 ‘ : ALU  |«o0p S:Leaadm |+op | I;t:::e! : ;RO.:‘;I!
Interface Controller - ‘ . 1 .* eee {optional)
FiFo % == _IEI_t"
} | 7 1 |
1 i = PA 2 Interconnect
G
| | U
Task Frame ,', N J
Memory
—=] FIFO
1} A Processing Element
‘ Jr . . .
_— 01 Architecture exploits parallelism at all
¢ | J levels at minimal cost
¥

Stream Output o1 Each PA is highly optimized — can be as

. un " Il as 200 gat
Pipeline of Processing Arrays smat ds 5 9aTEs
1 PAs communicate using streams, shared
RAMs and shared scalars

1 Each PA is in own stall domain
Allows for FIFO flow control
Allows for highly parallel design



PICO Express Designs Data Path as
well as Control Logic

Host interface and memory mapping

Task frame memory to hold multiple windows of configuration
parameters for overlapped task execution

Controlling the execution order of Pas
Multi-buffered memories from single arrays in source
Memory arbitration

Flow control using streams

You can gain maximum benefits by understanding PICO’s
ability to design control logic



RTL and lts Location

RTL consists of
Compiler generated structural RTL for the design

Manually created behavioral RTL for “macrocells”

Macrocells are building blocks like adder, register, mux, etc.

Like the architectural template, RTL is hierarchically organized

RTL is in the rtl_package directory

Implementation Directory window: <implementation-name> /rtl_package

rtl_package directory contains
Synthesizable RTL

rtl/ - contains the compiler generated RTL for the design
macrocells/ - contains RTL for macrocells
synth/ - contains scripts for RTL synthesis tools
Simulation infrastructure and testbenches
scripts/ - contains scripts for RTL simulation and analysis tools

simu_stubs/ - contains testbenches and external stubs



PICO Express RTL Overview

Stream Input

p

|
l N
*-—-bf'_—m:fst E‘_’:cTiTinl? ‘_'_i PA1 |
e | lél o Like the architectural template, RTL is
. hierarchically organized
(v Iéhm <file_name>_ppa.v: Top level RTL for a PPA
«—_::_—Pfq <file_name>_paw_<n>.v: Wrapper for PA
number n

\

<file_name>_pa_<n>.v, and

Pipeline of Processing A) A .
<file_name>_pe_<n>.v: RTL for PA
number n
'.'.r.'.—"—.-.‘.—.‘.—"—..—"—":"—"—"—":"—. .._.._..:.._.._.._.:.:.._..1.:\
| i1 Macrocells (addw.v, etc.)
: el o e |
Interface | & . . :é . (optional) .
SR .
LR ] I I E
o
S W . b

A Processing Array (PA)



Mapping of Code to a PPA: the C
Code

S e
char x[64], z[64];
Iint sum;

void ppa(void) {

int 1,dc=0;

char y[64];

for (1=0; 1<64; 1++) dc +=
x[i];

dc = dc >> 6;

for(i=0; i<64; i++) y[i] =
x[i]-dc;

sum = 0O;
for (i=0; i<64; i++) sum +=
;[i]*z[i];



High Level Mapping of Code to a PPA

char x[64], z[64];

& T, int sum;
i lntT?a‘ce N cgm?e ﬂw void ppa(void) {
c i int 1,dc=0;
ﬁ \ cha [641
¥ or (i=0; i<64; i++) dc +=
« -1 XLITS
*— N dc = dc >> 6;
TalakFrame Jv
emory
" : W
y 1§ x[i]-dc;
- L2 o
sur sum = 0;
\ ) 4 for (i=0; i<64; i++) sum +=
yLi 1




High Level Mapping of Data
=

char x[64], z[64];

y TN in um;
T Host [ Timing | o> void ppa(void) {
Interface Controller dc | - -
nt 1,dc=0;
char y[64];
Tor (1=0; 1<64; 1++) dc +=
) | dc | 1];
+— dc = dc >> 6;
Task Frame
Memory
B A for(i=0; i<64; i++) y[i] =
‘ v Ny x[i]-dc;
—t— |2
jsum] sum = 0O;
. J for (i=0; i<64; i++) sum +=
yLi]*z[i];

}



Mapping of C Operations To a PE
N

char x[64], z[64];
Iint sum;

void ppa(void) {

int 1,dc=0;

char y[64];

for (1=0; 1<64; 1++) dc +=
x[i];

Fixed Control

> 0;

Control
and Task-
Frame
Memory
Interface

+=0p Load/ |<+op Load/

Interconnect

A Processing Array (PA)
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Design and Verification

High Level Synthesis

the traditional RTL design process

Flow

. Verify/
Devel'op Evaluate/ Wirite RIL Simulated RTL Analyze
/Verify > Select > d > RTL Synthesi " Gate-level
Algorithm Architecture coce Code YIRS oe-.eve
Design

I

1

the design process utilizing behavioral synthesis

Develop Evaluate/ Genzrafe Simulated Verify/
. RTL Analyze
/Verify  —» Select > RTL > RTL Svnthesi > Gatelevel
Algorithm Architecture ccde Code YIRS are-ieve

< >

Design




Design and Verification Flow

Synthesis Flow

Design
Constraints
Driver _.___-_______-_-____-_-_-_____-_-_____‘_/____
7 ‘N\
! \
App.C l=p  preprocess \ #  schedule \
| \—/ \—/
L s

-

h—

Lint
Simulation

Bit accurate
SystemC
Simulation

ey Post-schedule

b o ) e o e

/

Threadaccurate
SystemC
Simulation

RTL Co-simulation
(SystemC)

RTL Simulation

\
I
I
[
l
¥
l
I
l

Backend
Tools



Synthesis Flow Components

Preprocess
High level program transformations like function inlining
Performs static checks for accepted C Syntax
Code generation for Lint simulation and Bit-accurate SystemC simulation

Schedule

High level program and loop optimization and loop scheduling

Code generation for Post-schedule C simulation and Thread-accurate
SystemC simulation

Synthesize

Instruction level optimization and scheduling, resource allocation and RTL
creation

Generation of RTL simulation and RTL co-simulation testbenches

Package

Collect relevant information in an easily accessible place to work with
other tools like Synopsys DC



Verification and Performance
Modeling Flow (1)

Golden C simulation
Runs original ¢ code using gcc
Compares the results against reference output
Or produces golden output for comparison during later phases

Lint simulation
Performs dynamic checks to catch errors early on
Un-initialized variable
Bitsize overflow and underflow
Out-of-bound array accesses
Post-schedule C simulation
Produces test vectors for RTL simulation

RTL Simulation

Verifies that the RTL is correct using test vectors produced by the above
phase

Allows user-controlled or random perturbation of operating conditions



Verification and Performance
Modeling Flow (2)

Bit-accurate SystemC simulation
Transaction-level simulation for functional verification

Thread-accurate SystemC simulation

Transaction-level simulation for performance estimation
Models parallel behavior of hardware

Runs significantly faster than RTL

RTL Co-simulation
Transaction-level simulation at the hardware level
Verifies RTL and interaction with the host processor



Representative Key Flows

Lint to detect errors early on
Golden Simulation = Preprocess =2 Lint Simulation

Performance Estimation

Golden Simulation 2 Preprocess = Lint Simulation = Schedule
—> Thread accurate SystemC simulation

RTL simulation

Golden Simulation > Preprocess = Lint Simulation 2 Schedule
—> Post-schedule C simulation = Synthesize 2 Package 2
RTL simulation

RTL co-simulation

Golden Simulation = Preprocess = Lint Simulation > Schedule
= Synthesize 2 Package = RTL co-simulation



GUI Overview

Implementations
Lag

sources

headers

data

results

PICO Express

data

info

Logs

Reports

simulation
http://www.synfora.com € 2004-2007 Synfora Inc. All Rights Reserved.

pico:[quadratic:-]=

set_project_params -projdir fhome/sjy oon/training 2007/modulel/quadratic
Project directory now set to: /home/sjy oon/training 2007/ modulel/guadratic
pico:[quadratic:-]> select_experiment a0

<no exp= select_experiment al

pico:[quadratic:a0]> |




Exercise 1-1

Start PICO Express in GUI mode (if not already running)
Shell> peg
(alias of pico_express —g —GCC /opt/gce-3.2.3/bin)
Open quadratic project
File OpenProject... ~/exercisel
Open the file app.c to understand the source code
Select implementation a0

Run Default flow on implementation a0. The Default flow
doesn’t run any RTL simulation

Look at the results in the Watch Window. If the Watch
Window is not visible, select it from the View menu

Questions
What is the clock frequency for this design?
What is the PICO estimated area for this design?



Implementation Directory View in GUI

It allows access to relevant information about an
implementation
data: Data input files for the application

info: Intermediate files giving more information about
program transformations

Logs: Logfile for each command
Reports: Reports providing feedback about the design

rtl_package: Collects the whole design including RTL,
testbenches and scripts in one directory

src: Source and header C files for this implementation

simulation: Data used or produced during various simulation
step

Work: Temporary workspace



Analysis Tools in GUI

PPA Graph

Shows the computation blocks (loop nests) and the data
structures used for communication

PPA graph is the anchor point for looking at design
characteristics

Resource Browser
Shows the hardware resources used in the RTL

Function units, registers, memories, streams

Shows C source mapping and aggregate cost reports



Exercise 1-2

Navigate through the implementation view

Show all accessible files
Show the PPA graph

Show resource browser and aggregate cost report

Show summary results report
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Memories and Arrays

Arrays may map to:

External memories — (compiled by a memory compiler outside of the PICO-
generated RTL)

We call these user_supplied

Synthesized memories — (flip-flops for RAM, logic for ROM)

We call these internal_fast

Registers/Wires — In certain cases, the compiler can eliminate arrays entirely
and map to appropriate registers or wires

This transformation is called Scalarization

To control external (user_supplied) vs. synthesized (internal_fast)
memory:

Use #pragma user_supplied <array>

Use #pragma internal_ fast <array>

Defaults are based on array size

For RAM, if an array has <= 16 entries OR <= 256 bits it will default to
internal_ fast
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Performance Specification -- Basics

Performance constraints drive the parallelism and the
number of hardware resources in an implementation

To explain performance constraints, we need to
explain the following two concepts
What is a “task”

The compiler-directed parallel/overlapped execution of C
programs used in PICO Express



What is a Taske

void ppa();//PPA procedure

int main (int argc, char

**argv) {
int ppaid,i;

ppaild =
PICO _initialize NPA
for(1=0; 1<N:#
ppa();
}

PICO _finalize NPA(ppaid);
¥

Task corresponds to a single
execution of the top level PPA
procedure that gets converted
to hardware

One task is one runtime call of t
he procedure ppa

In the code to the left, there will
be N tasks, one for each call to
procedure ppa



C Sequential Model vs. RTL Parallel Model

------ 1
|
Ll . el Data Stationary
= - ll (N et Schedule
. LD LD 1 ¢
T3 N wl| LD T :
Copy| Sel Sel o| T TTTTT T T ]
Sel L Copy| sel | sl | 0] T 07T w| 'LD ------ :
' T Sel 2 Copy | Sel | Sel wo| T T w| LD T -:
L I R - e e —S e e ) . m s E e e . .
1ime Manonary |copy| sel | sl Sel | * copy| sel | sel | LD LD LD '
Schedule Tl T Talalatel " T """ Tol T 1
+ Copy | Sel | Sal Sel L3 Copy | Sel |ff Sel LD LD LD 1
I—} ] ST + Copy | Sel | Sel Sel = Copy | Sel | Sel LD LD LD " |
o T ST + Copy | Sel I Sel sel | * Copy| Sel | Sel | LD o :- o
------ ST T + Copy Sil Sel o Sel e Copy | Sel | Sel LD TTene -----":
------------ - ——-——-
ST + Copy | Sel | Sel Sel = Copy| Sel | Sel | LD 1
5T + Copy | Sel | sel o Sel LJ Copy | Sel | Sel
I/ st [T + Copy| sel | sel Tsa | - J
ST + Copy | sel | sel T :
o |77 + Copy | Sel | Sel |
st | + 1
’ L[] D L[] L Sl A S (. J
o1 Programmer’s view: Data stationary view s :

What happens on a loop iteration

1 Hardware designer’s view: Time stationary view

What happens on a clock cycle



How to Measure Performance at the

Task Level?

Like any pipelined execution, there are two measures associated

with the overlapped task execution

How fast tasks can be started? That is, what is the time between the start of

a task and the start of the next task?e

This determines the throughput of the system

How long does it take to complete a task? That is what is the time between

the start and end of a task?

This determines the latency of a task

i

Time between the start
of two tasks

|

TIME

L1

L1

L2

L2

L3

L3

Time to complete
a task

Blue and Red represent two different tasks



PICO Terminology: MITI and Task Latency

Minimum Inter-task Interval (MITI)

Minimum time between the start of

two tasks 1
MITI
That is, how fast tasks can be started ; Task
L2 Latency
Task Latency L1
L3
Time to complete a task "
For execution with task overlap l
L3
MITI < Task Latency TIME
For execution with no task Blue and Red represent two different tasks

overlap
MITI = Task Latency



Performance Specification in PICO
Express

Performance is specified using two parameters
Clock Frequency in MHz
MITI in cycles

They are specified by opening the panel:

Implementation> Configure [New... | Current...] 2
General



Specified Performance vs. Delivered

Performance
—

7 PICO Express uses MITI at compile time to design hardware
meeting the performance

71 Delivered performance may be different

o1 PICO Express provides simulation based performance charts to
analyze delivered performance



Simulation Based Performance Chart
S

Difference is MITI Difference is Task Latency
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Coding Restrictions

Use arrays instead of pointers
Structured code — no goto

No floating point

No structs, unions, switch /case
No static, volatile declarations

No outer-loop around sequence of loops
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Coding Issues

Loop Transformation

Array Partitioning

Affine Array Indexing
Logical vs Bitwise Operations
Reducing Multiplier

Reducing Porting



Loop Transformation
N

o PICO'’s coding restriction
21 No outer-loop around sequence of loops

Possible Impossible

f10{ f20){
for(inti=0:i<100; ++i){ for(inti=0:1i<100; ++i){
for(int j = 05 j < 100; ++j){ for(int j = 0 ; j < 100; ++j){
for(int k =0 ; k < 100; ++k){ for(intk = 0 ; k < 100; ++k){
...Code... ...Code...
! }
} }

} for(int ii = 0 ; ii < 100; ++i){
for(intii =0 ; ii < 100; ++i){ for(intjj =0 jj < 100; ++j){
for(intjj =0 jj < 100; ++j){ ---code---
'”COde”'




Loop Transformation
N

7 We need transformation!

71 Outer Loop Case 1 : Sequential Loop Jamming

f10{ f104{
for(inti=0;1<M; ++i){ for(inti=0;i<M; ++i){
for(intj=0;j <NO; ++j){ for(int jj= 0; jj < NO+N1; ++jj){
LO; if(jj < NO){
} j =i
for(intj=0;j<N1; ++j){ LO;
L1; }

telsed
j=is
LO;




Loop Transformation
N

7 We need transformation!

-1 Outer Loop Case 2 : Unrolling

f1(){ f1(){
for(inti=0; i< M; ++i){ for(inti=0;i<M; ++i){
for(intj=0;j <NO; ++j){ for(intj=0;j < NO; ++j){
LO; LO;
} }
for(intj=0;j<N1; ++j){ #pragma unroll j
L1; for(intj=0;j < N1; ++j){

L1;




Loop Transformation
N

7 We need transformation!

71 Outer Loop Case 3 : Task Overlap

f10{
for(inti=0;1<M; ++i){
for(intj=0;j < NO; ++j){
LO;
}
for(intj=0;j<N1; ++j){
L1;

//PPA code
f104{
for(intj=0;j < NO; ++j){
LO;

1
for(intj=0;j<N1; ++j){
L1;

//Driver code

Int main(){
for(i=0;i<M; i++)f1();

¥




Loop Transformation
N

7 We need transformation!

71 Outer Loop Case 4 : Fully Parallel

o1 Not possible when there’s a feedback from L1 to LO

f10{ f104{
for(inti=0;1<M; ++i){ for(inti=0;i<M; ++i){
for(intj=0;j < NO; ++j){ for(intj=0;j < NO; ++j){
LO; LO;
} }
for(intj=0;j < N1; ++j){ }
L1; for(inti=0;i<M; ++i){

for(intj=0;j < N1; ++j){
L1;




Loop Transformation
N

7 We need transformation!

71 Outer Loop Case 5 : Parallel Loop Merging

104 f1(){
for(inti=0; i< M; ++i){ for(inti=0; i< M; ++i){
for(intj = 0;j < NO; ++j){ for(intj =0 j < NO; ++j){
LO; LO;
} L1;
for(intj=0;j < N1; ++4j){
L1;




Array Partitioning
N

71 Assume calculation on line 5 should take only 1 cycle by

constraint
o1 Need 4-port memory for original design
o1 Need single port memory after partitioning

1 char in[4][1024], out[1024]; 1 char in0[1024], in1[1024], in2[1024],
2 void qpp(){ in3[1024], out[1024];
3 inti; 2 void app(){

4 for(i=0;i<1024; ++i){ 3 inti;
5 out[i] = 4 for(i=0;i<1024; ++i){

(in[O][i]+in[1][i]+in[2][i]+in[3][i])/4; | 5 out[i] =

(inO[i]+in1[i]+in2[i]+in3[i])/4;




Logical vs Bitwise Operation

Logical operators often lead to more hardware
comparators than the bitwise operators.

Replace “&&” and “| |” with “&” and “|” with
caution



Reducing Multiplier
T

1 Make PICO recognize common sub-expressions and
reduce number of multiplier

7 Assoc. and dist. transformation are not always bit
equivalent in 2’s complement arithmetic due to
overflow and underflow

//original //[transformation 1 //transformation 2
x = -a*b+c*(d+e); x = =(a*b)+c*(d+e); tmp1 = a*b;
y = a*b+c*d+c*e; y = (a*b)+c*(d+e); tmp2 = c*(d+e);

X =-ml+ m2;

y =ml + m2;




Reducing Porting

1 Reduce memory porting by restructuring the code

if(mode == 0) if(mode == 0){
m = X[a][b]; tmpl = q;
else if (mode == 1) tmp2 = b;
m = X[c][d+e]; }
else else if(mode == 1){
m = X[d][e]; tmpl = c;
tmp2 = d+e;
}

else if(mode == 2){
tmpl = d;
tmp2 = e;

}
m = X[tmp1][tmp2];
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Exercise 2

Lint error debugging
Debug the program “exercise2”
It is a modified version of “three_filters” for testing
inlining
It has no compile error but has a lint error

Run “Lint” procedure to detect error and with this

information, compare “excercise2” and “three_filters’

You should edit the source file in implementation
directory to make it take effect



Exercise 2

S 07.02-2
[T S N .

ra, lnc. Al rights reserved.




Exercise 2

o Select the architecture a0 on Project View by

double clicking

COX

PICO Express (fhome/sjyoonfexercise?)
File View Project |mplementation Group BRun Analyze Window Help
] B = = N T
@& RS EEE W EA 4498 E 2 RTRAED
Active Implementation: <Not Selected>
............................................................................................................................ HlEFEFTFT g
Configure New Implementation Project View | Implementation Direi
£ Synfora
| exercise2 <Implementation ...
Run -
—Groups /X
Default 5] =
B Golden C Simulation PlCO Express
B PreProcess »headers
B Lint Simulation —data - v
| m-results il
ﬂ pico:[exercise2-]> set_project params -projdir /home/sjyoon/exercise2 ﬂ Input Input Clock | Estimated  Deliv
| | Project directory now set to: /home/sjyoon/exercise2 i MITI Frequency | Cost MITI
(Cycles) | (MHz) (Gates) (Cyc
a0 0 100 N/A

pico:[exercise2:-]>

|Open Project completed successfully




Exercise 2

1
ect Lint Process

PICO Express (/home/sjyoonfezercise?)

0 Se

B=)E3

Analyze Window Help

Eile View Project

Implementation

Group RBun

@ @2l =EE | EA 44 Q5 LRI RBERED
Active Implementation: a0
............................................................................................................................ Pl el | e i
Configure New Implementation Project View | Implementatiun[ll S
=4 Synfora
exercise2 al
Run N
—Groups data ———
Lint ¥ ®-Implementat. .. p-info /X
= Lao F-Logs '
Configure g _
Build F-SOUMCEs Reports PlCO EX[CJI'ESS
-headers B-simulation
—data F-src er—— Tl
H-results o E-Work ¥
I l—[ I —
E pico [exercise2:-]= set_project_params -projdir /home/sjyocon/exercise2 E Input Input Clock Estimated Deliv 7|
| | Project directory now set to: /home/sjyoon/exercise2 5 MITI Frequency | Cost MITI
pico [exercise2-]> select_experiment al (Cycles) | (MHz) (Gates) (Cyc
<no exp= select_experiment al al 0 100 N/A
pico:[exercise2: al]=
i I o
|Sei Active Implementation completed successfully




Exercise 2

71 Run

PICO Express (/home/sjyoon/exercise?)

A=E3

Eile View Project |mplementation Group Bun Analyze Window Help
1@ Bl =S ] B[4 & 4 & & 2R AERAEQ

Active Implementation: a0

.................................................................................................................................................................................................................. Ml
Configure New Implementation Project View |E Implementation DIE
%4 Synfora
exercise2 al
Run _ .
—Groups data ——
Lint ®-Implementat. .. -info /X
. . Lao m-Logs
B Golden C Simulation L sources Reports PlCO EXpI’E‘SS
B PreProcess +-headers F-simulation
B Lint Simulation —data rste e T
BHresults ¥ B-Worlk |/
= 2 J
ﬂ pico [exercise2-]= set_project_params -projdir ‘/home/sjyocon/exercise2 ﬂ Input Input Clock | Estimated | Deliv]
| | Project directory now set to: /home/sjyoon/exercise2 MITI Frequency | Cost MITI
pico [exercise2 -]= select_experiment a0 (Cycles)  (MHz) (Gates) (Cyc
<no exp> select_experiment al a0 | 100 MIA
pico: [exercise2 al]>
= e
|891 Active Implementation completed successfully




Exercise 2
o
1 Compile failed because of syntax error

o Edit fir.c file on Implementation View

PICO Ezpress (/home/sjyoon/exerciseZ)

B[(=1ES

File Wiew Project |mplementation Group Bun Analyze Window Help

e allel =aE u=H]s 8000 FERELR L

Active Implementation: a0

............................................................................................................................ o i || s |
Contigure New Implementation Project View | Implementation e
‘ exercisez Reports -
Run . . -
—Groups m-simulation ——
Lt ] m-Implementat. .. [ /X
| Lag i
Il Golden C Simulation o sources PICO Express
B FreProcess -headers
. Lint Simulation = T !
i BHresults w
= LI 2| 2|
_ﬂ picol|exercised:-|= selelct_experlmem at A ﬂ Input Input Clock  Estimated  Deliv |
-:lnole:-:p> sleleclt_experllment a0 MIT] Frequency  Cost MIT]
pl{;:o.[gxemlslzz.an]:» csim -golden (Cycles) ' (MHz) (Gates) (Cye
al: csim -golden -
ERAOR: compile failed. a0 0 100 N/A
fir.c: In function "'macc_shift"
fir.c:30: syntax error before )' token
i | pico:[exercisez:al]> 7 I =
|c Golden Simulation failed A




Exercise 2

- Edit

File Edit Tools Syntax Buffers Window Help

pEHEE 9 ?[é%[@-?é@IEiB*I“‘E%I

28
27
28
29
30
21
32
23
24
35
38
37
38
39
40
41
42

25 Bhort y3[L][M2-NI;

char task_num;

short macc_shift(short a, sho 5 I t shift_am
short result = partial su@ + ((a*b) == shift_amount);

return result;

i

void fir() {
int 1,7;

// Create a fixed, 31-point rectangular window with cutoff frequ

const short w3[N] = {ox0032,
oxfffz,
Ox0243,
oxffaz,

0x000f,
Ox00=1,
Ox0207,
oxff7f,

oxftfes,
OxQ00c2,
Ox0lab,
oxffoz,

oxffths,
Ox013a,
Ox013a,
Qxffhs,

25,1

oxffoz,
Ox0lab,
Ox00c2,
oxffes,

oxf
Ox0
Ox0
o) 0]

458




Exercise 2

e
=1 Lint Error

WARNING:2039:Isim:pico_lint.c:338

In function 'macc_shift' called at fir.c:50

WARNING:fir.c:30: Shift value 18446744073709551587 out of legal range (0,31)
END WARNING

WARNING:2000:Isim:pico_lint.c:507

WARNING:fir.c:52: Width overflow for "y[0]" type i13, value —31998 (0xffff8302).
END WARNING

WARNING:2000:Isim:pico_lint.c:507

WARNING:fir.c:61: Width overflow for "y2[0][0]" type i13, value —4643
(Oxffffeddd).

END WARNING

WARNING:2000:Isim:pico_lint.c:507

WARNING:fir.c:69: Width overflow for "y3[0][40]" type i13, value 4158 (0x103e).
END WARNING




Exercise 2
]

7 Negative shift amount?

File Edit Tools Syntax Buffers Window Help
PEHEAE e tEaDI Rk BES %O B
50 sum = mace_shift(wlj], x[task_num]l[i+7], sum,(IEEEI:EEEfiEEEEID;
51 )]
52 y[1] = sum;
53 1}
=4
2o
55 for (1=0; 1 = M2-N; 1++) {
57 short sum = y2[task_num]l[1];
58 for (j=0; 7 < N; J++) {
58 sum = mace_shift(w2[j], y[i+]]1, sum, (EXPY-EXPX-EXPW));
80 );
61 y2[task_num][1] = sum;
62 }
63
g4  for (1=0; 1 = M2-N; 1++) {
65 short sum = y3[task_numl[1];
66 for (j=0; 7 < N; J++) {
57 sum = mace_shift(w3[j], y[i+]]1, sum, (EXPY-EXPX-EXPW));
50,70




Exercise 3

Fibonacci

Basic approach

Implement simple program by your hand
Write driver code and ppa code

Driver code is for initializing the input, setting up the PPA and
printing the output.

PPA code is for synthesizing the hardware. Should be synthesizable
C code which meets PICO’s coding constraints

If you are not familiar with PICQO, it is okay to use existing
programs for framework

Sliding window

See “Writing C Application” page 32 for reference
( )


http://iris.snu.ac.kr/synfora/Writing_C_apps.pdf
http://iris.snu.ac.kr/synfora/Writing_C_apps.pdf

Exercise 4

Implement 5-tap FIR FILTER
without streaming

5-tap filter needs 5 pixel at
once to filter

Create intermediate pixel “x”
using a 5-tap FIR filter. Filter
all pixels horizontally in this
manner(top left to bottom
right)

And then, create final pixel
“x” using a 5-tap FIR filter.
Filter all pixels vertically in this
manner. (top left to bottom
right)




Exercise 4

Horizontal filtering
for(j = O + MARGIN; j < HEIGHT+ MARGIN; j++){
for(i = 0 + MARGIN ; i < WIDTH + MARGIN; i++){
short output = (c[4] * yin[{][i-2] +

c[3] * yin[{][i-1] +

c[2] * yin[{][i 1+

c[1] * yin[{][i+1] +
c[O] * yin[{][i+2] )>>3;

yinter[j][i] = output;

}
}



Exercise 4

Vertical filtering
for(jj = 0 + MARGIN; jj < HEIGHT + MARGIN; jj++)1
for(ii = O + MARGIN ; ii < WIDTH + MARGIN; ii++){
short output = (c[4] * yinter[jj-2][ii] +

c[3] * yinter[jj-1][ii] +

c[2] * yinter[jj][ii ]+

c[1] * yinter[jj+ 1][ii] +

c[O] * yinter[jj+2][ii] )>>3;

yout[jil[ii] = output;
}
}



Exercise 4
B

o1 Current design operates...

host Each memory is
NN / full size of the
Input memory (yin) picture frame
NNRVRVAY
Loop O, task 1

NRURVAN

Intermediate memory(yinter)

MR

Loop1, task]

NRVRVRN

Output memory (yout)

NRURVRN

host



Homework

Implement 5-tap FIR FILTER with internal streaming
and sliding window to improve performance

Problems of previous implementation

Memory for full size of picture frame is needed — large
memory

Large number of memory access occurs

It prevents parallel execution of LoopO and Loop]
because of data dependency between LO and L1

These problems can be solved by streaming and
sliding window



Streaming Data (1)

Streaming data enables parallel execution of communicating loop nests

Communicate via 2-way handshake

. . o Loop 0, Task 1 Loop 0, Task 2
Time-independent synchronization
“Block-on-read” — no peeking VALV AAL 34400 A
Loop 1, Task 1 Loop 1, Task 2
Specification for external streams: time
Use <type> pico_stream_input—mame>Cvord)—tnpon >

Use void pico_stream output <name>(<type>) (output)

The user should write these procedures to define the communication between driver
and PPA via streams

Specification for internal streams:
Use FIFO(<name>, <type>) to declare inter-loop FIFO
Use pico_stream_iInput _<name> and pico_stream_output<name>

The stream procedures are automatically generated by the FIFO macro



Streaming Data (2)

What happens when we call pico_stream_*?2

In software — procedure call
The code for the pico_stream_* procedure is executed

For internal streams this procedure comes from the FIFO macro and is
predefined by PICO Express

For external streams this procedure is user-defined and can do anything the
user wishes

In hardware — data handshake
Each data stream has 3 signals - data, ready, request

When pico_stream_* call is encountered, the request is asserted (either for
read or write)

If the corresponding ready is true, the transaction takes place and the PA
proceeds

If the ready is false, the PA stalls and continues asserting request until ready
goes true



Streaming Data (3)

Without streams, the PPA would always execute in a pre-
determined time

Streams introduce variability due to dynamic L_O
synchronization and flow control ,',
Waiting for input data to be available
Woaiting for output buffer to be free
Producer and consumer block independently wlr
The computation is still deterministic L1

Streams may cause deadlocks due to bounded buffers
#pragma fifo_length x 4

Deadlocks can always be removed by increasing FIFO sizes.

However, this may indicate unintended sequentialization in the

code



Streaming Data(4)

Example Code

Function pico_stream_output_y()
is for external streaming. It is
manually implemented in the
driver code by user and does
something, for example, writing
value of y[j] to output file.

Function pico_stream_output_z()
and pico_stream_output_y()
are for internal streaming. It’s
code is automatically
generated by PICO. Function
pico_stream_output_z() writes
“x[j] + offset” to FIFO and
pico_stream_input_z() reads
value from FIFO.

int x[100],y[100],z[100];

FIFO(z, int)

extern Int pico_stream output y(int);
Iint offset;

void ppa(void) {

}

int j;

for(J=0;J<100;j++) {
yO1 = x0O1*x01;
pico_stream output z(x[j]toffset);

s

for(j=0; J<100; j++){
pico_stream output y(y[iD:

}

Tfor(J=0;J<100;j++){
z[J] = pico_stream i1nput_z();

}



Sliding Window

A sliding window is variable with the following properties:

It is declared as a one-dimensional array in procedure scope.

All references have compile-time constant indices.

It is an argument to a single pico_shift procedure call.
Within a for-loop, at most shift locations can be written, where shift
is the shift argument to the pico_shift call. In addition, the locations
written must have consecutive indices.
The pico_shift() call takes two arguments:

The array to be shifted
Must be a single dimensional array
Must be declared in procedure scope
The shift amount
Must be a compile-time constant
Must be between one and the array size minus one



Homework
—

1 FIFO is used to keep the data
from LO which filters horizontally

= What L1 needs is the data in
vertical order while FIFO fires
the data in horizontal order.
In the L1, Someone should keep

the data from FIFO and
provides data access in vertical

HEEEEEEEEE
order ] HEEEEEEEE
Sliding window can be used HEEEEEEEN

HEEEEEEEEE

here

11 Sliding windows should keep
more than 4 lines to provide
vertical data access to L1 One set of data

forming vertical line

New data from FIFO

Data in sliding window



Homework
N

11 Revised structure with stream and sliding window
host

NRRYRN

Input memory (yin)

N\

Loop O, task 1

NN NN
FIFO(stream)

NN NN
Loop1, task] < Sliding Window

NN
Output memory (yout)

NRURVRN

host



Homework
N

7 Sample Result of fir filter with shared memory

LOOPS
Lo |

L1

0
Time [Cycles]

100000

=

200000 300000

I e

F-TaskD 263448
|:Lﬂ 8 126728
L1 126728 053448 0




Homework
N

o Sample result of fir filter with stream

0 50000 100000 150000
Time [Cycles]




	PICO EXPRESS TUTORIAL�DIGITAL SYSTEM DESIGN METHODOLOGY LAB CLASS
	Contents
	Contents
	Introduction
	High Level Code Structure
	Real Code Example
	Real Code Example
	Real Code Example
	Architecture Template for PICO Express Hardware
	PICO Express Designs Data Path as well as Control Logic 
	RTL and Its Location
	PICO Express RTL Overview
	Mapping of Code to a PPA: the C Code
	High Level Mapping of Code to a PPA
	High Level Mapping of Data
	Mapping of C Operations To a PE
	Contents
	Design and Verification Flow
	Design and Verification Flow
	Synthesis Flow Components 
	Verification and Performance Modeling Flow (1)
	Verification and Performance Modeling Flow (2)
	Representative Key Flows
	GUI Overview
	Exercise 1-1
	Implementation Directory View in GUI
	Analysis Tools in GUI
	Exercise 1-2
	Contents
	Memories and Arrays
	Contents
	Performance Specification -- Basics
	What is a Task?
	C Sequential Model vs. RTL Parallel Model
	How to Measure Performance at the Task Level?
	PICO Terminology: MITI and Task Latency
	Performance Specification in PICO Express
	Specified Performance vs. Delivered Performance
	Simulation Based Performance Chart
	Contents
	Coding Restrictions
	Contents
	Coding Issues
	Loop Transformation
	Loop Transformation
	Loop Transformation
	Loop Transformation
	Loop Transformation
	Loop Transformation
	Array Partitioning
	Logical vs Bitwise Operation
	Reducing Multiplier
	Reducing Porting
	Contents
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 2
	Exercise 3
	Exercise 4
	Exercise 4
	Exercise 4
	Exercise 4
	Homework
	Streaming Data (1)
	Streaming Data (2)
	Streaming Data (3)
	Streaming Data(4)
	Sliding Window
	Homework
	Homework
	Homework
	Homework

